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Introducgao

A cartilha de fechamento de arquivos foi elaborada com o objetivo de facilitar o
processo de criacao e fechamento de arquivos, abordando desde os aspectos
iniciais, como a diferenca entre paletas de cores e indicacdes do gabarito, até a
etapa final de exportacao do(s) arquivo(s).

Nesta cartilha vocé tera acesso a inumeras instru¢des referentes aos padrdes de
impressao da Atual Card. Estas instrucdes precisam ser seguidas para garantir o
melhor resultado naimpressao dos seus materiais graficos.

Este documento contém um resumo do conteudo instrucional disponivel no
site. Caso nao encontre a informacao que busca ou deseje aprofundar em

algum dos assuntos, acesse a area de “Instrugdes”, no site da Atual Card, para
conferir todo o contetudo de apoio disponivel.

https://instrucoes.atualcard.com.br

Deus é tudo!
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DEFINIGAO DE COR E SUAS DIFERENGAS

A cor nada mais é do que uma percepc¢do visual da retina. Essa percep¢ao visual
transmite impressdes ao sistema nervoso por meio de informacdes pré-
processadas no nervo éptico, que sao interpretadas pelo cérebro como cores. Por
isso é comum que em locais escuros e quase sem luz, o ser humano veja apenas
as cores preto e branco, pois ndo ha raios luminosos suficientes para que haja a
definicao das demais cores.

Ha dois tipos de cor que podem ser percebidas: a cor Luz, obtida aditivamente, e
a cor Pigmento, obtida subtrativamente.

A cor Luz é obtida por objetos que emitem luz, como é o caso do sistema de cor
RGB, presente em monitores, celulares e televisores. Nesse caso, as cores sao
formadas pela adicao de diferentes comprimentos de onda das cores primarias
deluz:vermelho (R), verde (G) e azul (B).

No segundo sistema (cor Pigmento), a cor é dada por meio da insercao de
pigmentos, e ndo de luz, como é o caso da paleta de cor CMYK, em que a superficie
sem pigmento (branca) € manchada pelas cores ciano (C), magenta (M), amarelo
(Y) e preto (K), que, ao se misturarem, formam as demais tonalidades.

RGB, CMYK E PANTONE

E a abreviatura do sistema de cores formado
por vermelho (red), verde (green) e azul
(blue) que, ao se misturarem por completo,
formam a cor branca. O propésito principal
do sistema RGB € a reproducdo de cores em
dispositivos eletrénicos, como monitores de
TV e computador, datashows, scanners,
cameras digitais, celulares e outros
dispositivos.
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O CMYK é um padrdo de cor utilizado em
impressdo grafica, cuja sigla corresponde a
ciano (C), magenta (M), amarelo (Y) e
preto (K). Essas cores, ao se misturarem por
completo, formam o preto.

Como o CMYK utilizado na industria grafica é
baseado na mistura de tintas sobre o papel,
quando ele é reproduzido em dispositivos
eletrénicos, ndo passa de uma variacdo do
RGB. Portanto, nem todas as cores vistas no
monitor serdo reproduzidas fielmente na
impressao, uma vez que o numero de

possibilidades de cores no CMYK é cM K
significativamente menor do que no RGB.

Fique atento: Alguns softwares incorporam filtros que tentam apresentar, no
monitor, uma prévia de como a imagem sera impressa, mas mesmo assim havera
variacao nastonalidades.

O Pantone® é o sistema numérico de cores
de tintas criado pela empresa Pantone. Este
sistema é baseado em misturas especificas
de pigmentos para criar novas cores,
permitindo a criacdo de cores metalicas e
fluorescentes e sendo amplamente utilizado
em industrias téxtil, de plastico e de tintas. O
Pantone também pode simular tonalidades
de cores formadas pela paleta CMYK, que
ficam marcadas na guia das cores da
empresa.

Ao montar sua arte grafica, é preciso
atentar-se que o sistema Pantone,
visualizado no computador, € composto por
cores-luz, e que aimpressao é realizada com
a paleta de cor CMYK, ndao sendo possivel
reproduzir determinadas tonalidades.

ATENGAO: A Atual Card aceita
somente arquivos enviados em
CMYK, por isso é importante
que seu arquivo seja revisado e

enviado utilizando apenas

cores da paleta CMYK. A ;:}?EIL‘OC ARD o 5




DIFERENGAS ENTRE AS OPGOES DE COR 1X0, 1X1, 4X0, 4X1 E 4X4

As impressfes em CMYK sdo feitas utilizando quatro canais de cor (quatro
pigmentos diferentes): o ciano (C), 0 magenta (M), o amarelo (Y) e o preto (K). Ao
misturar esses canais (pigmentos) é possivel criar umainfinidade de cores.

Os numeros (0, 1 e 4), que representam a quantidade de canais de cor que serao
utilizados na impressao de cada um dos lados do papel, sao identificados da

seguinte forma:

A impressao sera realizada apenas em um
dos lados do papel (frente) e utilizara
somente o canal K (preto) da paleta de cor
CMYK, resultando em uma impressao
somente na cor preta, bem como suas
variacbes emtons de cinza.

A impressdo serd realizada utilizando
apenas o canal K (preto) da paleta de cor
CMYK, isto é, somente na cor preta (e suas
variacbes em tons de cinza) em ambos os
lados do material (frente e verso).

A frente do material sera impressa
utilizando os quatro canais de cor do CMYK,
isto é, a impressao sera colorida. O verso
ndoreceberaimpressao.

A frente do material sera colorida (quatro
canais de cor do CMYK), enquanto o verso
sera impresso utilizando apenas o canal de
cor K da paleta CMYK, resultando em
impressao em preto e tons de cinza.
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Tanto a frente quanto o verso serdo
impressos coloridos, ou seja, utilizando os
qguatros canais de cor do CMYK. o ATI ANITIC
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COMO CONVERTER CORES PARA CMYK

Va até o menu Editar > Localizar e Substituir

> Substituir Objetos COREL DRAW

Arquive | Editar | Babir  Layout Objete  Efeitos  Bitmaps Texte Tabela F

EI D ‘j Desfazer Excluir Ctrl+Z |I| III FOF 112%
A 1C :
an3 v: 17 (" Repetir Excluir Ctrl+R 1 40|00 O b g
E ﬁ c Gerenciador Desfazer
Al | e 1] 2000
ﬁ AN Eg Recortar Ctrl+X !
Y Copiar Ctrl+C
Ly ' Colar Ctrl+V
r, g n
Q"‘ : iﬁ Excluir Exccluir
-Il;wj D Duplicar Ctrl+D
f'b ﬁ: i"ﬁr Clenar
- Copiar propriedades de..,
D‘ : Executar etapa e repetir Ctrl+5Shift+D
O"‘ - Selecionar tudo 3
G‘ ﬁ_ Lecalizar e substituir b ETHI Localizar objetos... Ctrl
A‘ e E'ﬂ Substituir objetos...
AM Localizar texto...
*/: AM? Substituir texto...
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Selecione a op¢ao “Substituirum modelo ou paleta de cores”

Assistente de substituicdo X

Seja bem-vindo ao Assistente de substituicdo.

Este assistente o ajudara a pesquisar seu desenho e a localizar
ohjetos que possuam determinadas propriedades. Ele o ajudara
a alterar as propriedades dos objetos que localizar.

Substituir uma cor

(@ Substituir um modelo ou paleta de cores

Substituir propriedades da caneta de contorno

Substituir propriedades de texto

Aplicar somente aos objetos selecionados atualmente

Avancar %J Cancelar

Selecione “Localizar qualquer modelo ou paleta de cores”. Na op¢do “Substituir
pelo modelo de cores”, deixe como CMYK, e na op¢do “Substituir cores usadas
como”, use “Preenchimentos”.

Assistente de substituigdo % X

Selecione o modelo ou paleta de cores que vocé deseja
localizar e o modelo de cor pelo qual deseja substitui-lo.

® Localizar qualquer modelo ou paleta de cores

Logalizar modelo de cores:

Localizar paleta de cores:

Substituir pelo modelo de cores: CMYK -
Substituir cores usadas como
\ ® Preenchimentos Contorngs

e e T
ER| [H]]

¥| Aplicar aos preenchimentos gradientes

¥| Aplicar aos preenchimentos de padrio de 2 cores

~| Aplicar aos bitmaps monocromaticos

Voltar Concluir Cancelar
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Repita o processo para contornos, selecionando a opgdo correspondente.

X

Assistente de substituicdo

Selecione o modelo ou paleta de cores que vocé deseja
localizar e o modelo de cor pelo qual deseja substitui-lo.

® | ocalizar qualquer modelo ou paleta de cores
‘ Logalizar modelo de cores;

Locglizar paleta de cores:

Substituir pelo modelo de cores: CMYE -
Substituir cores usadas como

Preenchimentos @ Contornos

¥| Aplicar aos bitmaps monocromaticos

Voltar Cancelar

Escolha o modo de cor CMYK sempre que for abrir
um nNovo arquivo. Para isso, basta escolher CMYK na
opc¢ao “Color Mode” (Modo de Cor).

PHOTOSHOP

Mew Iﬁ
Mame: Movo | DK |
Preset: Custom - T Reset |
| Save Preset... |
Width: 2732 Pixels - Delete Presef
Height: 768 Pixels -
Resolution: 72 Pixels/Inch -
Color Mode: | RGE Color : 8 bit hd
Bitrmap
Background Contents: -
: e Grayscale [ Image Size:
RGB Color |
¥ Advanced CMYK Color |, 6,00M
Lab Color |

Deus é tudo!
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Também é possivel alterar o modo de cor depois que seu arquivo estiver aberto.
Primeiro confira qual modo de cor vocé esta usando. No exemplo abaixo estamos
usando o modo de cor RGB.

PSs File Edit Image

b » 7 AutoSeleck | Group

Movo @ 100% (RGB/E)

Para altera-lo, basta acessar o menu “Image” (Imagem), “Mode” (Modo) e CMYK
Color.

PS File Edit Image ‘i Type Select Filter Mew Window Help

Bitrmap

: Grayscale
Adjustments »
Duotone
Auto Tone Shift+Ctrl+L Indexed Color...
Auto Contrast Alt+5Shift+Ctrl+L | v RGB Color
Auto Color Shift«Ctrl+B  |J Color

Lab Color
Multichannel

Image Size... Alt+Ctrl+1

Canvas Size... Alt+ Ctrl+C

Image Rotation 8 Bits/Channel

Crop 16 Bits/Channel
Trirm... 32 Bits/Channel
Reveal All - =

Color Table...
Duplicate... I
Apply Image...

Calculations...

Vanables L4

Trap...

Analysis 4

Deus é tudo!
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Escolha o modo CMYK sempre que iniciar um novo

arquivo. Para isso, basta selecionar CMYK em ILLUSTRATOR
“Advanced” (Avancado) e definir o “Color Mode”

(Mode de Cor)como CMYK.

Name:

Profile:  Hash Builder B

Mumber of Artboards: 5

Size: 800 x 600
H800px | Units: | Pixels
ﬂeight: Orientation: [y E%

Bottomn Right

To Left
stcec: = [ETHNN = [0 = TS = X
* Advanced
Color Mode: RGB
Raster Effects: = Screen (72 ppi)
Preview Mode: Default -

+ Align New Objects to Pixel Grid

Templates... 4 Cancel

Também é possivel alterar o modo de cor depois que seu arquivo estiver aberto.
Primeiro confira qual modo de cor vocé esta usando. No exemplo abaixo estamos
usando em RGB.

Al File Edit Object Type Select

Mo Selection .T T

2 Movo @ 98% (RGE/Preview) =

Deus é tudo!
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Para altera-lo, acesse o menu “File” (Arquivo), selecione a opc¢ao “Document Color
Mode” (Modo de Cor do Documento) e selecione a opcao CMYK Color.

Ai File Edit Object Type Select Effect View Window Help  Be | [F

Ctrl+M
w - - 2 pt Owal -

Mew...

[

Save Selected Slices...

Mew from Template.., Shift+Ctrl+N
Open... Ctrl+0
[s Open Recent Files O
-*-\ Browse in Bridge... Alt+Ctrl+0
__.QI‘J Close Ctrl+W
o Save Ctrl+5
‘/1 Save As,., Shift+Ctrl+5
ﬁ’ Save a Copy... Alt+ Ctrl+5
= Save as Template...
,H"I‘ Save for Web... Alt+Shift+ Ctrl+5

-

4 Revert F12

Place...

;'ii:f

:s:@ Save for Microsoft Office...

= Export...

- |

* Scripts K
Docurment Setup.., Alt+Ctrl+P |
Document Color Mode k| ChWYE Color
File Info... Alt+5hift+ Ctrl+I v RGB Color

S —

DIFERENGAS ENTRE IMPRESSAO DIGITAL E OFFSET

A impressao digital é feita com o auxilio de um computador, sendo o arquivo
transferido diretamente para a impressora. Normalmente em uma impressora
digital sdoimpressas tiragens de até 250 unidades.

A impressdo offset é destinada a grandes tiragens, geralmente acima de 500
unidades, devido a sua capacidade de impressao em alta escala. A impressao
offset é realizada por meio da gravacao de chapas, feitas pelo CTP (Computer-to-
Plate - processo de producdo das chapas). E gravada uma chapa para cada um dos
quatro canais de cor CMYK, que juntos formardo as cores do produto final.
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Aimpressao do material (digital ou offset) podera variar de acordo com o produto
adquirido e com as demandas do setor de producao.

m GABARITOS/PADROES

Os gabaritos (também chamados de padrdes) representam uma importante
fonte de auxilio na hora de criar as artes graficas dos impressos. Por meio deles, o
cliente tem acesso as informac¢8es sobre margens de seguranca, linha de corte e
sangria dos produtos. Cada produto apresenta um gabarito diferente, portanto é
obrigatério que se utilize o padrao correspondente ao produto adquirido.

Evite utilizar gabaritos ja salvos em seu computador, uma vez que a grafica pode
alterar/atualizar os gabaritos disponiveis nosite.

UTILIZANDO 0S PADROES/GABARITOS

Os gabaritos/padrbes estao
disponiveis para download
em Corel Draw, Photoshop e
lllustrator. Siga corretamente
as instrucdes contidas nos
arquivos, sempre respeitando
as margensindicativas.

Argarecarp 13



MARGEM DE SEGURANGA, LINHA DE CORTE E SANGRIA

Esses trés elementos sdo importantes recursos presentes nos gabaritos, que
auxiliam a produzir seu impresso da maneira correta, ajudando a criar a arte
grafica no tamanho adequado e evitando que haja informacdes cortadas ou que
areas brancas aparecam no produto final.

MARGEM DE
SEGURANGA

LINHA DE
CORTE

SANGRA

CORTE

SEGURANGA

As margens de seguranca servem para que Vocé
tenha uma noc¢do das areas do arquivo que nao
serdo cortadas. Por isso todas as informacdes
importantes e que ndo podem ser cortadas devem
ficar para dentro desta margem.

As linhas de corte mostram aproximadamente o
local em que o seu material sera cortado. Ndo use
esta linha para demarcar o fim da sua arte, nem
coloque qualquer informacdo nessa area, ja que ela
€ passivel de corte.

A sangra serve para garantir que o fundo do seu
arquivo apareca por completo, fazendo com que
nenhuma area branca apareca. Essa area ndao pode
conter nenhuma informacdo importante, somente o
fundo da arte.

SANGRA
CORTE
SEGURANGA
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UTILIZAGAO CORRETA DA COR PRETA

A cor preta merece cuidado especial na hora de criar as artes graficas para seus
impressos. Para que seu produto tenha o melhor resultado possivel, ha
orientacBes especificas para cada tonalidade de preto. Veja abaixo cada uma
delas:

O termo “preto carregado” refere-se a um tipo de preto
PRETO que ndo é aceito em impressao grafica. Quando a soma
CARREGADO de todos os canais de cor da paleta CMYK superar 320%,
esse preto serd carregado. Ou seja, uma carga muito
grande de tinta sera liberada, fazendo com que a
impressao venhaaborrarou grudar em outros papéis.

Exemplo de preto carregado: 90 85 100 95

C90M85Y 100 K95 =
90+85+100+95 = 370% de cor. =

cC M Y K

Caso o arquivo seja enviado com preto carregado, ele serd colocado em
pendéncia e a equipe de Arte-final abrira uma solicitacao para que o problema
seja resolvido pelo cliente. Somente apds o reenvio do arquivo corrigido é que o
pedido entrara em producao.

*Nao produzimos nenhum arquivo com preto carregado.

Este preto € recomendado para ser utilizado no fundo
PRETO das artes de seus arquivos e € indicado somente para
FUNDO impressdes offset. Por conter 40% de ciano em sua
composicao, se for utilizado em impressao digital, o
preto saira comtom azulado.

A configuracao do preto 40 0 0 100
fundo é C40 MO Y0 K100
(Ciano 40%, Magenta 0%,
Amarelo 0% e Preto 100%).
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O preto puro é recomendado para ser utilizado em
textos ou curvas das artes de seus arquivos. Ele pode
ser utilizado tanto em impressao digital como offset.
Nado é recomendada a utilizacdo do preto puro no fundo
das artes, pois ele pode ficar com um tom marrom
escuro aposimpresso.

A configuracao deste preto 0 0 0 100

é CO MO0 YO K100

(Ciano 0%, Magenta 0%, . = .
Amarelo 0% e Preto100%).

cC M Y K

Utilizado para proteger textos com fundo preto. Esta
tonalidade deve ser usada como contorno em seus
textos quando eles estiverem a frente de um fundo
preto, pois, caso nao tenha um contorno, a tinta do
fundo podera "invadir" as outras cores durante a
impressao. Com essa protecdo, seus textos ficardo mais
nitidos.

A configuracao do preto 1 1 1 100
linhaéC1M1Y1K100
(Ciano 1%, Magenta 1%,
Amarelo 1% e Preto 100%).

Configuracao de preto utilizada para garantir que as
PRETO SOBRE tonalidades de preto figuem visiveis na impressao. A

PRETO utilizacdo de elementos pretos a frente de um fundo
com a mesma cor podem ndo sair na impressao, caso
ndao seja tomado o devido cuidado em relacdo a
porcentagem de cor utilizada.
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Exemplo de preto sobre preto utilizando quatro canais CMYK:

Para que todas as informacdes fiquem visiveis, deve-se manter uma diferenca de,
no minimo, 40% de cor entre o preto do fundo da arte grafica e o preto que estara
a frente do fundo, ficando a diferenca de 15% no canal K e os outros 25%
distribuidos nos demais canais.

60 60 60 85 265

Cc M Y K

70 70 65 100 305

Exemplo de pretosobre preto utilizando apenas o canal K(preto):
Caso o preto do fundo da arte esteja utilizando apenas o canal de cor K, a
diferenca de tonalidade entre o fundo e o objeto deve ser de, no minimo, 15%.

cC M Y K

0 0 0 85 85
1

cC M Y

0 0 0 100
1

C M Y

ArvareCarp 1]




DEFINIGAO DE OBJETOS E SUAS CARACTERISTICAS

Os objetos nada mais sao do que os elementos utilizados na criacao de uma arte.
Imagens, fontes, curvas, gradientes, sombreamentos e demais efeitos sdo
objetos e, para cada objeto, é necessario ser tomado um cuidado especifico.

Elementos como fontes, por exemplo, devem ser convertidos em curvas. Ja
efeitos, como gradientes, lentes e sombreamentos, devem ser transformados em
imagens CMYK, e a resolucdo de suas imagens devem ser maiores ou iguais a 300
DPIs.

COREL DRAW - TRABALHANDO COM OBJETOS EM CAMADAS

Para saber quais objetos e quais (ou quantas) camadas estdo ativas, basta abrir o
Gerenciador de Objetos. Nessa area é possivel verificar quantos objetos seu
arquivo tem e se possui efeitos ou textos. Também é possivel verificar qual o
modo de cor e quais cores estdao sendo utilizadas na arte grafica.

Gerenciador de objetos

Paginal =
. nt qﬁ qi Ca?‘nadal : g‘u_
= {] Pagina 1 :
@ & @ [l Linhas-guia -
= @ g ] Camada 1 =
A Texto artistico: Arial (Mormal) (PTE] - Preench: ( IE_
# Curva - Preench: C:0 MO Y20 K2100, Contorno: M ‘:"
A Texto artistico: Arial (Mormal) (PTB) - Preench: (
# Curva - Preench: C:0 M:0 Y20 K2100, Contorno: M O
= [ Retédngulo - Preench: C:0 M40 ¥:20 K20, Contorn | =
Lente r,_:'D,_
I'4 Bitmap (CMYK) =
B Retdngulo - Preench: C:100 M:0 Y0 K20, Contorn @
El ] Pagina 2 o
@ F @ [l Linhas-guia 5::-
@ 'h g ] Camadal e
El (] Pagina principal E‘
@ &Y @l Linhos-guio (todos os pdginas °
@ E ] Arec de trobolho 4
o Grode de documentc :
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COREL DRAW - CONVERTER OBIJETOS EM CURVAS

E importante converter fontes e outros objetos em curvas. Para converter um
objeto em curvas, acesse 0 menu “Objeto” e selecione a opc¢ao “Converter em
Curvas”, ou utilize o atalho "Ctrl+Q".

E}j CorelDRAW X8 (64 Bit) - Sem titulo-1
Arquive  Editar  Exibir  Layout | Objeto | Efeitos  Bitmaps Texto Tabela  Ferramer

e ld 4 7y i}l Inserir codigo de barras...

53 X:[1,585 cm we 2,011 crt @5 Inserir novo objeto... ]
¥ 3,2 cm P 1672 en O@E Vinculos...
Sem titulo-1
Y ‘ Lo Simbolo y —
i il ..._...........-_......._..._...... el
é.y_. | PowerClip ]
i Transformagdes 3
) : b
Alinhar e distribuir b
Q‘ Ordenar [
+ |
o, |
|
|
I:' | Grupo F
O | Ocultar K
O I Eloguear b
F
/3\‘ ol Formato 3 I
|(::? Conwerter em curvas Ctri+Q)
fJ [ E Converter contorno em objeto Ctrl+5Shift+
5_}‘ Unir curvas
-i Impressdo sobreposta do preenchimento
gl- Impressdo sobreposta do contorno
B
/’ | Dicas de ohjeto
‘e -5 Propriedades do chjeto Alt+Enter
Q‘ | »' Gerenciador de objetos

Deus é tudo!
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COREL DRAW - CONVERTER OBJETOS/EFEITOS EM IMAGENS BITMAP

Bitmaps | Texto Tabela Ferramentas Ja Alguns objetos, como gradientes,
[ Converterem bitmap.. N = textura; e Ien'Fes deverrj ser
g convertidos em imagens, ja que

71 somente a transformagao em curvas

ndo vai resolver determinados
problemas na hora da conversdo.
Para converter objetos em imagens,
basta ir ao menu “Bitmaps” e
escolher a opc¢do “Converter em

Bitmap”.
Maodo b

Converter em hitmap X Lembre-se de utilizar a opgéo “Modo
. O — de cor” com cor CMYK. E Importante

esolugdo: |E'.l "’|d|ﬂl , . ~

: S0 também configurar a resolucdo para

ar
Modo de cor: | Cor CMYK (32 bit) - 300 DPIs (no minimo).
Opgdes

| | Suavizacdo de serrilhado

+| Fundo transparente
Tarnanheo do arquive descompactado: 236 KB

GKL\? | Cancelar Ajuda

ILLUSTRATOR - CONVERTER EFEITOS EM VETOR

Selecione o elemento que contém os efeitos a serem convertidos, clique no menu
“Object”, e em seguida selecione “Rasterize”.

Najanela seguinte, defina as seguintes op¢des:
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Rasterize

Color Model: = CMYK

Resolution: = High (300 ppi)

Background
White

(=) Transparent

Options

Anti-aliasing: = Art Optimized (Supersampling) |+ @

Create Clipping Mask

add: = [ Around Object

+ Preserve spot colors

PHOTOSHOP - CONVERTER EFEITOS EM VETOR

Layer Type Select Filter View Window Help Cllque no menu Layer >
Mew T —— . .
Rasterize e em seguida
selecione a op¢dao “Layer”
(camada) ou “All Layers”
(todas as camadas).

Duplicate Layer...
Delete

Rename Layer...
Layer Style 4

Smart Filter

Mew Fill Layer
MNew Adjustment Layer 3

Layer Content Options...

Layer Mask

Vector Mask L4
Create Clipping Mask Alt+ Ctrl+ G

Smart Objects

Rasterize Type

Shap
Mew Layer Based Slice 3 anE

Fill Content
Group Layers Ctrl+G Vector Mask
Ungroup Layers Shift+Ctrl+G Smart Object

Hide Layers Layer Style

Arrange h Layer

Combine Shapes |  All Layers
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ACABAMENTOS

CORTE ESPECIAL

O corte especial € um acabamento que permite deixar o desenho do corte dos
produtos com formatos diferenciados. Que tal um cartao de visita redondo,
triangular, ou com o formato de uma camera fotografica, um carro, uma
garrafa ou qualquer outro desenho?

O acabamento de corte especial permite isso, mas possui algumas regras que
devem ser respeitadas. Dentre elas, possuir uma area de sangra de 2,5mm para
dentroe 1,5mm paraforadalinha de corte do material.

E importante também evitar desenhos muito complexos, com linhas muito

proximas umas das outras e pontas agudas para garantir a qualidade do impresso

final.
ARTE COM SANGRA CORTE ESPECIAL PRODUTO FINAL

DOBRA E VINGO

Muitas pessoas confundem essas duas palavras, entendendo-as como a mesma
coisa, entretanto dobra e vinco sao acabamentos diferentes.

A dobra é feita de maneira automatica, por meio de uma dobradeira, e esta
disponivel para materiais com gramatura menor que 170g.
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Ja ovinco € uma marcacado feita no papel, por meio de um processo mecanico, em
gue a maquina bate em uma determinada area do material, formando uma
pequena "lombada" e facilitando a dobra do impresso posteriormente. O vinco
esta disponivel para materiais com gramatura igual ou maior que 170g.

O furo € um acabamento utilizado geralmente em tags, cartelas de bijuteria,
etiquetas, solapas e calendarios de parede, e serve para pendurar os materiais e
facilitar a sua exposicdo. O acabamento de furo esta disponivel nos tamanhos
3mm e 5mm. Caso ndo esteja incluso no produto que deseja adquirir,
dependendo do material € possivel adicionar o acabamento durante o processo
de compra.

SANGRA
CORTE
SEGURANGA

Atencdo! O furo deve

ficar dentro da area de éun %ijﬂ S \
§ "%% 4

seguranca do gabarito, (%@%%

pois caso haja variagdo
no corte, o furo poderd
ser cortado.

m' . ‘**44“ B

B ywwsunsingiasses
WWW SURSUnglassescom t %
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A serrilha é um acabamento (bastante utilizado em comandas, rifas, carnés,
boletos e bloco de notas fiscais) realizado no material para facilitar o destaque de
uma das partes do impresso.

E necessario manter uma margem de seguranca ao redor da linha em que ser4
realizada a serrilha. Essa area deve ser de 2 mm para cada lado da indicacao.
Deve-se também manter uma distéancia de, no minimo, 2cm entre a serrilha e a
borda do papel.

Tomando esses cuidados vocé garantira que a serrilha do seu impresso fique

correta.
. N +2mm: cﬁ
+2mm N (@) o)
4 & m|& |2
e @[>
3 =
ol 7 g
o <o e ) ~
T wadB% \\ ............................ LG
desconto 1 0 (y
; e : :

TAMANHO MENOR

O “tamanho menor” é um acabamento com a fun¢ao de deixar o material comum
tamanho inferior ao adquirido no site.

O tamanho minimo para esse acabamento é 4x4cm em gramaturas de 250g e
300g e de 7x7cm em gramaturas inferiores a 250g.
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Atencao: Caso deseje um corte diferenciado ou um tamanho menor do que os
mencionados acima, sera necessario adquirir o acabamento de corte especial.

Para folders nas gramaturas 75g, 80g, 90g, 120g, 150g, o tamanho minimo para
que seja possivel adicionar o acabamento de tamanho menor é de 7cm. Em
impressos menores do que 7cm nao é possivel a confeccdo.

Veja abaixo como deve ser feita a arte grafica de um cartdo de visita com o
acabamento detamanho menor:

Object  Effects

/8.3 em -
]|:| 43 cm * -

dr Untitled-1

UNQUN ,

s l

WY WM;SUHSMHH@J[@BSC&EOM F

Para um cartdo com o tamanho final de 8x4cm, deve-se deixar a arte da seguinte
maneira:

Areade sangria deve ter 0,3cm (3mm) a mais do que o tamanho final (8,3x4,3cm).
* Amargem de seguranca deve serde 0,35cm

Atencgdo! Ao adquirir este acabamento, é necessdrio informar o tamanho final
desejado na janela que se abrira ao selecionar o acabamento, durante o processo
de compra.
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ESPELHAMENTO DE FACA

Os acabamentos de corte especial, serrilha, dobra e vinco merecem uma atencao
especial na hora de serem produzidos. Para garantir que o acabamento fique
conforme o desejado € necessario espelhar as artes e verificar se nenhuma
informacdo do verso corre o risco de ser danificada. Vamos usar imagens para
exemplificar o espelhamento das artes.

CORTE ESPECIAL

Corte Especial

Faca: € o contornoemvermelho nasimagens.

Note que a faca da frente fica espelhada com a faca do verso. O arquivo deve ser
feito desta forma para que se tenha certeza de como o verso vaificar em relacao
afrente.
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Espelhando a faca
corretamente, o
resultado final, apds o
corte, sera conforme
imagem ao lado:

Lembre-se de que o corte especial possui uma margem de 2mm para dentro e 1,5mm
para fora dafaca.

A serrilha possui uma margem de 2mm para os lados da linha principal de
indicacdo. E necesséario espelhar a arte, certificando-se de que as informacées
importantes ndao serao cortadas.

DOBRAE VINCO

Para produzir corretamente seus arquivos que ja possuem dobra e vinco como
acabamento incluso, faca o download do gabarito e utilize as margens de
seguranca de dobra. Utilize uma margem de seguranca de 5mm para cadalado da
marcacao dadobra.

Caso o produto tenha duas dobras, dois vincos ou uma dobra deslocada, sera
necessario fazer o espelhamento da arte grafica para garantir que o acabamento
seja aplicado corretamente. Ja para produtos com uma dobra centralizada ou trés
dobras ndo sera preciso fazer o espelnamento.
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ARQUIVO “MASCARA”

Chama-se “mascara” os arquivo utilizados para indicar quais areas ou elementos
da arte grafica deverdo receber a aplicacdo de coberturas ou acabamentos, como
verniz localizado e hot stamping. A mascara também pode ser utilizada como
“calco de cor” para materiais produzidos no PVC transparente + branco e no papel
supremo metalizado, deixando as areas indicadas na mascara opacas, com um
calco de cor branca por baixo da tinta para que nao fiquem transparentes (no caso
do PVC transparente + branco) ou metalizadas (no caso do papel supremo
metalizado).

MASCARA DE VERNIZ

A mascara de verniz € utilizada nos produtos que possuem cobertura de verniz
localizado. Nesses produtos é indispensavel o envio desse arquivo para que seja
possivel identificar os locais/elementos em que o verniz deve ser aplicado.
A mascara precisa ser exatamente do mesmo tamanho do produto que vocé esta
adquirindo.

Isso quer dizer que se a cobertura de verniz precisar ser aplicada em um texto, é
imprescindivel que a fonte desse texto seja igual e do mesmo tamanho, tanto na
arte grafica quanto na mascara. O mesmo acontece comimagens e logos.

No arquivo referente a mascara, as areas/elementos que deverdao receber a
aplicacdo dovernizlocalizado devem estar na cor preta (CO MO YO K100).

Arte

DEMETRIO S

Advocacia | OAB/SC 000000

1l Miscara
Verniz
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MASCARA DE HOT STAMPING

Para o Hot Stamping é necessario um cuidado a mais na criacao tanto de arte
grafica quanto da mascara pois o processo de aplicacdo desse acabamento é
diferenciado.
A aplicacdo do hot stamping é feita por meio de uma chapa de metal que, quando
aquecida sobre a lamina com a cor desejada, transfere a cor da lamina para o
papel.
Porisso é aconselhavel que os objetos (logo, imagem, texto, etc.) que receberao o
acabamento estejam apenas no arquivo mascara, nao sendo indicada a insercao
destes na arte grafica, ja que se houver alguma variacao na aplicacao do efeito, a
imagem da arte ficara deslocada e aparecera noimpresso final.
Deve-se também enviar a mascara em vetor, garantindo maior qualidade ao
acabamento.

Arte Mascara Hot Stamping

Cores Disponiveis:

- Azul

- Dourado

- Prateado ‘
- Rosa :
- Vermelho ‘

Produto
Final

MASCARA DE PVC TRANSPARENTE + BRANCO

O calco branco no PVC transparente faz com que algumas partes do material
fiqguem opacas, ou seja, sem o efeito de transparéncia, criando um belo contraste
com as informacdes que possuem transparéncia. O envio da mascara é
necessario para que sejam identificadas as areas e os elementos que ndao devem
ter transparéncia.
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Mascara

Arte Branca

Produto
Final

@

MASCARA METALIZADA

Toda a frente do supremo metalizado possui uma camada que deixa o papel com
aspecto metalico. Caso algumas partes do seu impresso precisem ficar sem esse

aspecto € necessario enviar uma mascara indicando (com a cor preta) os locais
que nao devem ficar metalizados.

Assim como o PVC transparente + branco, deve-se tomar o mesmo cuidado na
montagem da mascara do material metalizado.

Arte Mascara Metalizada

- Toda a linha de ferramentas + Todu a linha de ferramentas
* Oleos * Oleos

FERRAMENTAS = 3 g FERRAMENTAS = « Canos
L2 L35 = FERRAMENTAS =

Muqumus

* Mdquinas

(00) 98781 1515 | 1w (00) 98781 1515

Rua da Luz, 1764 - Bairro - Cidade

- www.boltferramentas.com -

Produto Final

Rua da Luz, 1764 - Bairro - Cidade
= www.boltferramentas.com -

Deus é tudo!
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OVERPRINT (IMPRESSAO SOBREPOSTA)

A impressao sobreposta (overprint) € uma opcdao de configuracdao do
preenchimento de um objeto. Softwares graficos permitem essa configuracao
(algumas vezes até aimpde), mas € preciso utiliza-la com muito cuidado e apenas
sevocé tiver certeza dasuaaplicacao.

Normalmente, na imagem gerada para a impressao, € deixada uma “reserva” de
papel em branco embaixo de cada objeto, como mostra aimagem abaixo:

4 )
\. J
( A
\L J
( )
L J
Ciano Magenta Preto
( N N )
TEXTO
\. J \. J \ J

Repare que, mesmo havendo objetos coloridos abaixo da palavra “TEXTO”, as
cores, nesta area coberta pela palavra, ndo serao impressas. O mesmo acontece
com o objeto em ciano. A area que esta sendo coberta pelo objeto magenta nao
seraimpressa.
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As cores sdo separadas desta maneira para que apenas as partes visiveis de cada
objeto sejam impressas, e o resultado final figue como visto a baixo:

Ao ativar a impressao sobreposta a um objeto, as cores desse objeto serdo
impressas sobre as cores dos objetos que estiverem abaixo.

Utilizando a imagem anterior, veja como ficaria a separa¢dao das cores com a
impressao sobreposta ativada a todos os objetos:

Ciano Magenta Amarelo

Perceba que, mesmo existindo o TEXTO cobrindo os objetos em ciano e magenta,
eles serdo impressos por inteiro, um sobreposto ao outro. Isso fara com que as
cores se misturem no papel, resultando em uma impressao muito diferente da
visualizada anteriormente.
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Exemplo de situa¢bes onde serdo impressos textos, linhas ou pequenos
objetos de cor escura sobre uma area de cor mais clara:

Convites
Papelaria Personalizada
Lembrancas

VAVAV,

Casamento ® Aniversdrio

Em caso de variacao no registro (encaixe das cores CMYK uma sobre a outra),
mesmo que essa variacdo seja pequena, pode gerar uma faixa sem impressao. O
resultado disso sdo textos borrados e dificeis deler.

No caso deste exemplo, a impressao sobreposta ativada nos objetos em preto
faria com que o preto fosse impresso sobre as demais cores. Como o preto foi
aplicado sobre as cores ciano e amarelo, os objetos em preto sofrem mudanga na
cor,ndoficando como o desejado.
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Convites
Papelaria Personalizada
Lembrangas

\VAVAV/

Casamento * Aniversdrio

2ranca.

aranca. 7 W w

AVAV)

. Ao ud
EA'J!

COMO ATIVAR OU DESATIVAR A IMPRESSAO SOBREPOSTA?

Cligue com o botdo direito do mouse sobre o objeto e
COREL DRAW em seguida selecione “Impressdao sobreposta do
preenchimento”.

LY CorelDRAW X7 (64 Bit) - Sem titulo-1 - 0O X
Arquive  Editar Exibir Layout Objeto Efeitos Bitmaps Texto Tabela Ferram L
MR = K B K= ") e ﬂ ;',“J d’ﬁ, @ 249% - Tipo de quadro [
pen X 45,5 mm w4 13,409 mm 2000 % o i) a | €75 Converter em curvas Ctr+Q
g : L 3 3 a 0,0 =] |'_|,“__I e 8| X o

¥: 19,839 mm % 6,219 mm 2000 % % Desagrupar CirlsU
| | Exemplos.cdr Sern titulo-1 | o Desagripar tudd N
g —_— e T oo VSR Circundar o texto do pardgrafo S S B0 SRl
», = :
l :H] Linha de conexdo de circundamento
- e @  Desfazer Mover Ctrl+Z
= : N S<  Recortar Ctrl+X
% { g Copiar Ctrl+C
“n. |
“ | Onv‘ I Excluir Excluir
D‘ : | i Qrdenar 3
= ape ar’a er Estilos de objete 3
Lf‘ i Estilos d res 3
Links da Internet 3
Ay = : .
| Impressdo sobreposta do preenchimento
|
Ea : !
n\n ' Dicas de objeto
.
3 | Propriedades do objeto Alt+Enter
- ___, Simbolo »
& | L
. |
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A confirmacdo de que a impressdo sobreposta foi ativada fica evidente na barra
de status. Uma marcac¢ado sera adicionada a cor do preenchimento ou contorno:

(48981;-1,001) [ Secundaria Grupe de 4 objetos em Camada 1 = & M om0 v:0 K80 & X Nenhum

Acesse o0 menu Window e em seguida selecione

".'."STRA"’R Attributes (atalho Ctrl +F11).

Ai File Edit Object Type Select Effect View Window

Group D - 'a' -

Exemplos.ai* @ 511% (CMYK/Preview) =

MNew Window

- Arrange [

[

Workspace 3
Extensions r

Control

Tools

Actions V

Align Shift+F7
Appearance Shift+F6
Artboards

Attributes Ctrl+F11
Brushes Fa
Color & 3
Color Guide Shift+F3 ot

Document Info

AROBNNN A

i

Flattener Preview

Com o objeto selecionado, a janela Attributes
— . mostrara se a impressao sobreposta (overprint)
esta ativada paraaquele objeto.

Existem duas formas de controlar as impressdes
sobrepostas. Assim como no lllustrator, a janela
Attributes controla a Impressao sobreposta do objeto.

Por objeto: Acesse o menu Attributes: Window >
Output> Attibutes
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View [Mindow | Help Recosoft | B 413~ | v W~ W~

i "1 [How - 0@~ B
Workspace 3 r . (O 0% ) |
B Articles
Bl color o P O U
v | Control Alt+ Ctrl+6
Editorial 3
Effects Shift+Ctrl+F10
Extensions k
Info F& s
Interactive 3 V -|- e S
v Layers F7
v Links Shift+ Ctrl+D
Mini Eridge
Object & Layout k "L
) ( Output ] Attributes 1
v Pages F12 Flattener Preview !
Stroke F10 Preflight Alt+5Shift+ Ctrl+F
Styles b Separations Preview Shift+Fo
Text Wrap Alt+Chrl+W Trap Presets

= gofek
Type & Tables k g

Com o objeto selecionado, a janela “Attributes” mostrara se a impressao esta
ativada para aquele objeto.

ATTRIBUTES

Crwerprint Fill Owerprint Stroke

Monprinting Orwerprint Gap

A particularidade do InDesign é que, por padrao, o software da saida a todos os
objetos em black 100% com impressao sobreposta para evitar problemas de
registro em textos, por exemplo, que sendo impressos em black 100% sobrepde
aqualqueroutra cor.
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Essa configuracdo é ajustavel da seguinte forma: menu Edit > Preferences >

Appearence of Black.

-
Preferences

Ganarz| -
Interface

Type

Advanced Type
Composition

Units & Increments

Grids

Guides & Pasteboard
Dictionany

\ Spelling

Autoooemect

Motes

Track Changes

Story Editor Display
Display Performance
Appearance of Black
File Handling

Clipboard Handling

Appearance of Black

Options for Black on RGB and Grayscale Devices
On Screen: Display All Blacks as Rich Black -
Printing / Exporting: Qutput All Blacks Accurately -

Example of 100K Black Example of Rich Black

HAa HAa

Overprinting of [Black]
[¥] Overprint [Black] Swatch at 100%

Description

Checking "Owerprint [Black] Swatch at 100%" is best for printing or saving selected separations
and affects onby objects or text coloned with the [Black] (100K) swatch. This applies to PostSeript
and PDF output, Unchecking the option will result in all instances of [Black] knocking out
{removing) underhying inks, except where it is applied to an object s=t to overprint its fill or stroke,

[ oK | [ Reset

FECHAMENTO DO ARQUIVO

Esta é uma parte importante do processo, pois todo o arquivo deve ser verificado.
Tenha a certeza de que todos os elementos e fontes (textos) foram convertidos
em curvas e os efeitos, transformados em imagens CMYK. Confira também se o
seu arquivo esta inteiramente em modo CMYK e certifique-se que ndo haja
excesso de cor, formando o preto carregado ou outra cor muito carregada (acima
de 320%). Apds ter finalizado a conferéncia, basta exportar seu arquivo em JPG,

JPEG, CDRou PDF/X-1a.
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SALVANDO EM PDF/X-1a NO COREL DRAW

Para salvar em PDF/X-1a acesse o menu Arquivo e em seguida clique em Publicar
em PDF. Escolha o nome do seu arquivo e clique em “Configur.”.

Mome: | pdfxla =
Tipo: |PDF - Portable Document Format (*.pdf) |
Predefiniciio de POF: | ppEfc-1a -
+ Oaultar pastas Lonfigur, Salvar Cancelar

Na op¢ao “Compatibilidade”, escolha “PDF/X-1a” e logo em seguida selecione,
no menu superior, a aba Objetos.

Configuragéies PDF x|

Geral |Cn:|r ] Documento l Ohjetos | Pré-impressdo | Seguranca | i@ Menhuma questio |

Mome do
arguivo:
Faixa de exportacdo

* Documento atual  Pagina atual

Documentas Paainas: | 1
Selecan

Tamanha da pagina

Predefinicio de PDF: | porsonalizado {configuracies atusis nd... = | o =

Compatibilidade: PDF f¥-1a

-

oK, Cancelar Ajuda
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Na aba Objetos, deixe selecionada a opcao “Compactar texto e linha artistica” e
“Exportar todo o texto em curvas” e mude as seguintes op¢des: cor para 300, tons

de cinza para 300 e monocromatico para 1.200 (em algumas versdes, aparecera
“1.20").

Feitoisso, clique em OK.

Configuragdes PDF X

Geral Cor Documento | Objetos | Pré-impressdo | Seguranga quuestﬁn:n

Cafbjseiacan o Winky | Compactar texto e linha artistica

Tipe de compactagdo: Zp ¥ | [#]Exportar todo o texto como curvas
Texto e fontes

Rearnostragem do bitmap para menor

~.f 7
Lor 00 |2 “

+ Tons de cinza 300 :

¥ Monocromatico 1.200

Arguivos EP5:

Renderizar preenchimentos complexos c..

0K l: Cancelar Ajuda

Edit Object Type

Mew... Ctrl+M

Mew from Template... Shift+ Ctrl+MN

Open.. Ctrl+0

Open Recent Files 3

Cligue em “File” e escolha a

Browse in Bridge... Alt+Ctrl+ 0 Opgéo“Save As...”

Cloze Ctrl+W

Ctrl+5
Shift+Ctrl+5
Save a Copy... Alt+Ctrl+5

Save

Save As...

Save as Template...

Save for Web...

Alt+5Shift+ Ctrl+5

ArgaroCarp 39



Depois escolhaonome para o seu arquivo e escolha a opcao “Adobe PDF".

File name: pdfx1a.pdf v ‘ Save ’
Saveastype: | Adobe PDF (".PDF) »| | Cancel |
Use Artboards All Range: |1

Mude a opcdo “Adobe PDF Preset” para PDF/X-1a:2001.

Save Adobe PDF

Adobe PDF Preset:  [PDR/¥-12:2001] (Modified)

Standard: = PDF/X-1a:2001 » Compatibility: " Acrobat 4 (PDF 1.3)

General General

Compression
Marks and Bleeds| Description: [Based on 'PDFfX-13:2001"] Use these setfings to create Adobe PDF

Output documents that are to be checked or must conform to PDRX-1a:2001, an

il 150 standard for graphic content exchange. For more information on creating =
{'.du-ar!r.ud PDF/¥-1a compliant PDF documents, please refer to the Acrobat User Guide.
Security Created PDF docurnents can be opened with Acrobat and Adobe Reader 4.0
Summary!

Options
Embed Page Thumbnails

Optimize for Fast Web View

View PDF after Saving

Save PDF

Tenha certeza de que na aba Output, a opcao “Destination” esteja como: U.S. Web
Coated (SWOP)v2. Em seguida clique em“Save PDF".
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Save Adobe PDF

Adobe PDF Preset:  [PDFRX-13:2001] (Modified)

Standard: PDFf¥-1a:2001 * Compatibility: Acrobat 4 (PDF 1.3)

General Output
Compression
Marks and Bleeds

Output Color Conversion: = Convert to Destination
Advanced

Security Destination: | U.S. Web Coated (SWOP) v2
Summaryl

Color

PDF/X

Output Intent Profile Name:  U.S. Web Coated (SWOP) v2 )

Output Condition Name: [

Mark as Trapped

Description

Specifies a profile name (usually the Destination profile).

Save PDF Cancel

SALVANDO EM PDF/X1-A NO PHOTOSHOP

File Edit Image Layer Type Select Filt
Mew... Ctrl+M
Open... Ctrl+0
Browse in Bridge... Alt+ Ctrl+ 0
Erowse in Mini Bridge...

Open As... Alt+Shift+ Ctrl+0

Clique em “File” e escolha a
opcao“SaveAs...”

Open as Smart Object...

Open Recent

Cloze Ctrl+W
Close All Alt+Ctrl+W

Close and Go to Bridge... Shift+ Ctrl+W

Save Ctrl+5

Save As... Shift+Ctrl+5
l. -

Save for Web... Alt+Shift+Ctrl+5
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Definaum nome para o arquivo e escolha a op¢ao “Photoshop PDF”.

Metwork

File name: pdfxla -

Format: |PNG - PNG;*PNS) -] | Cancel |

) Photoshop (*.PSD;" FDD)
Save Options Large Document Format (*.PSE)
Save: BMFP (".BMF;*.RLE;".DIB)
CompuServe GIF (" GIF)
Photoshop EPS {*.EPS)
Photoshop DCS 1.0 (*.EPS)
Photoshop DCS 2.0 *.EPS)
Color: IFF Format (*.IFF;*.TDI)
JPEG ("JPG;".JPEG;”JPE)
JPEG 2000 (*.JPF;> JPX*JP2;* J2C J2K JPC)
JPEG Stereo (*.JPS)
Multi-Picture Format (*.MPO)

Thumbnail PCX [ PO
Ph 1:!1!= 0 1b {“PDF*POP} ]

Photoshop Raw (" RAW)

Piar (" PXR)

PMG (" PNG;” PNS)

Portable Bt Map (*.PEM;" PGM;" PPM;* PNM;” PFM;" PAM)
Scitesc CT (*.SCT)

Targa (" TGA;” VDA ICB;" V5T)

TIFF {* TIF;* TIFF)

Mude a op¢ao "Adobe PDF Preset" Para: PDF/X-1a:2001.

Save Adobe PDF
Adobe PDF Preset: [PDF/X-1a3:2001] ¥
Standard: PDF/¥X-1a:2001 v Compatibility: | Acrobat 4 (PDF 1.3)

General

Compression

Description:  |Jse these settings to create Adobe PDF documents that are to be

ml| »

Output checked or must conform to PDF/¥-12:2001, an IS0 standard for
Security graphic content exchange. For more information on creating PDF/X-13
compliant PDF documents, please refer to the Acrobat User Guide. o
Summary
Options

Preserve Photoshop Editing Capabilities
["1Embed Page Thumbnails
[T] Optimize for Fast Web Preview
[[] View PDF After Saving

Save Preset... | [ savePDF | [ Cancel |

Certifique-se de que na aba Output, a opcao “Destination” esteja como: U.S. Web
Coated (SWOP)v2. Depois de seguir esses passos, clique em“Save PDF”.
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Save Adobe PDF
Adobe PDF Preset: [PDF/¥-13:2001] ¥
Standard: PDF/X-13:2001 »  Cormpatibiity: | Acrobat 4 (PDF 1.3)
General Qutput
Compression Color
__ _ Color Conversion: Convert to Destination -
Security
Summary Destination: U.5. Web Coated (SWOP) v2 -
Don't Include Profile
PDFX
Output Intent Profile Name: U.5. Web Coated (SWOP) v2 -
Output Condition:
Output Condition Identifier: | CGATS TR 001
Registry Mame: | http://www.color.org
Description
Save Preset... | [ save PDF | | Cancel |

POSSIVEIS VARIAGOES

Devido a producdo ser em alta escala, durante o processo de produc¢dao podem
ocorrer algumas variacdes (minimas) na impressao, como cor, tamanho do refile
e quantidade. Para maiores informacgdes sobre o assunto, consulte os Termos de

Garantia da empresa.

Pode haver uma pequena variacdao de cor entre as
tonalidades vistas na tela do computador e as
impressas no papel, uma vez que ao visualizar a arte
grafica em midia digital, ha uma interferéncia de
brilho e luz, o que ndo acontece no material impresso.
A Atual Card também ndo garante plena fidelidade de
cor entre materiais impressos anteriormente na
grafica ou em impressos produzidos em outras
graficas.
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O processo de corte envolve uma guilhotina que
realiza o corte de um bloco inteiro com varias laminas
de papel. Nesse processo, pode haver minimas
variacdes. Para garantir que o material grafico fique
correto mesmo com a variacao, disponibilizamos
gabaritos que possuem uma area de seguranca para
que informac¢bdes importantes sejam sempre
preservadas. O uso dos gabaritos na criacdo dos
arquivos é obrigatorio.

Note que a imagem da esquerda recebeu o refile no local exato, enquanto na da
direita o refile ficou um pouco deslocado. Com essas imagens, pode-se notar a
importancia das margens de seguranca, ja que todas as informacdes
importantes foram preservadas na hora do corte, ndo afetando o resultado final
do produto.

Caso avariacdo seja bastante perceptivel, o cliente deve entrar em contato com a
central de atendimento e solicitar analise.

Como a producdo é realizada em alta escala,
trabalhamos com a variacdo de 10%, referente a
QUANT,DADE qua?ntidade adquirida no sitg, sendo a v.aria(;éo. para

mais ou para menos. Ou seja, se o pedido realizado
for de 1.000 unidades, o cliente podera receber entre
900 e 1.100 unidades do produto.
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